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Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death, serious personal injury, or property damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or property damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information that must be observed to avoid damage and injury or
improper use of the product. Be sure to read these instructions.

Note
Instructions including notes for operation and additional explanations.

Basics

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.
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Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, macOS, OS X, AirPort, App Store, AirPrint, the AirPrint logo, Safari, Bonjour, iPad, iPad

Air, iPad mini, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other
countries.

• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

• Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Drive, Google Apps
and Google Analytics are either registered trademarks or trademarks of Google Inc. Google Play and
Google Play Logo are trademarks of Google LLC.

• Adobe, Acrobat, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB
(1998) are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
• Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its

subsidiaries and/or affiliates in the USA and/or other countries.
• USB Type-C™ is a trademark of USB Implementers Forum.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2015 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.1.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work
and any modifications or additions to that Work or Derivative Works thereof, that is intentionally
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or
Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this
definition, "submitted" means any form of electronic, verbal, or written communication sent to the
Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of,
the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except
as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in4.
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;

and
3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works4.
that You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in
at least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works;
or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions
of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.
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6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright c 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2012, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com

Author: Bernhard Penz <bernhard.penz@fabasoft.com>

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
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MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 8: Apple Inc. copyright notice (BSD) -----

Copyright (c) 2007 Apple Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Inc. ("Apple") nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

---- Part 9: ScienceLogic, LLC copyright notice (BSD) -----

Copyright (c) 2009, ScienceLogic, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of ScienceLogic, LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
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IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

LEADTOOLS

Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

-----------------------------------------------------------

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote
products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-----------------------------------------------------------

MIT License

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright 2000 Computing Research Labs, New Mexico State University

Copyright 2001-2015 Francesco Zappa Nardelli

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COMPUTING
RESEARCH LAB OR NEW MEXICO STATE UNIVERSITY BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Written by Joel Sherrill <joel@OARcorp.com>.

COPYRIGHT (c) 1989-2000.

On-Line Applications Research Corporation (OAR).
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby
granted, provided that this entire notice is included in all copies of any software which is or includes a
copy or modification of this software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY.
IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND
CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY
PARTICULAR PURPOSE.

(1) Red Hat Incorporated

Copyright (c) 1994-2009 Red Hat, Inc. All rights reserved.

This copyrighted material is made available to anyone wishing to use, modify, copy, or redistribute it
subject to the terms and conditions of the BSD License. This program is distributed in the hope that it
will be useful, but WITHOUT ANY WARRANTY expressed or implied, including the implied warranties of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at
http://www.opensource.org/licenses. Any Red Hat trademarks that are incorporated in the source code or
documentation are not subject to the BSD License and may only be used or replicated with the express
permission of Red Hat, Inc.

(2) University of California, Berkeley

Copyright (c) 1981-2000 The Regents of the University of California.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The FreeType Project LICENSE

----------------------------

2006-Jan-27

Copyright 1996-2002, 2006 by
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David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

============

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and IJG (Independent JPEG Group) licenses, which
all encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

o We don't promise that this software works. However, we will be interested in any kind of bug reports.
(`as is' distribution)

o You can use this software for whatever you want, in parts or full form, without having to pay us.
(`royalty-free' usage)

o You may not pretend that you wrote this software. If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code. (`credits')

We specifically permit and encourage the inclusion of this software, with or without modifications, in
commercial products.

We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

"""

Portions of this software are copyright © <year> The FreeType

Project (www.freetype.org). All rights reserved.

"""

Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

===========

0. Definitions

--------------

Throughout this license, the terms `package', `FreeType Project', and `FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
`FreeType Project', be they named as alpha, beta or final release.

`You' refers to the licensee, or person using the project, where `using' is a generic term including
compiling the project's source code as well as linking it to form a `program' or `executable'.

This program is referred to as `a program using the FreeType engine'.
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This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive.

If you are unsure whether or not a particular file is covered by this license, you must contact us to verify
this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

--------------

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY
TO USE, OF THE FREETYPE PROJECT.

2. Redistribution

-----------------

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use, execute,
perform, compile, display, copy, create derivative works of, distribute and sublicense the FreeType Project
(in both source and object code forms) and derivative works thereof for any purpose; and to authorize
others to exercise some or all of the rights granted herein, subject to the following conditions:

o Redistribution of source code must retain this license file (`FTL.TXT') unaltered; any additions, deletions
or changes to the original files must be clearly indicated in accompanying documentation. The copyright
notices of the unaltered, original files must be preserved in all copies of source files.

o Redistribution in binary form must provide a disclaimer that states that the software is based in part of
the work of the FreeType Team, in the distribution documentation. We also encourage you to put an URL
to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

--------------

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this software
in your documentation or advertising materials: `FreeType Project', `FreeType Engine', `FreeType library',
or `FreeType Distribution'.

As you have not signed this license, you are not required to accept it. However, as the FreeType Project
is copyrighted material, only this license, or another one contracted with the authors, grants you the right
to use, distribute, and modify it.

Therefore, by using, distributing, or modifying the FreeType Project, you indicate that you understand and
accept all the terms of this license.

4. Contacts

18



-----------

There are two mailing lists related to FreeType:

o freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the library
and distribution.

If you are looking for support, start in this list if you haven't found anything to help you in the
documentation.

o freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.

Our home page can be found at

http://www.freetype.org

--- end of FTL.TXT ---

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit expressly
disclaim all implied, express or statutory warranties including, without limitation, the implied warranties
of merchantability, noninfringement of third party rights and fitness for a particular purpose. Neither the
developers nor the distributors will be liable for damages, whether direct, indirect, special, incidental, or
consequential, as a result of the reproduction, modification, distribution or other use of the TWAIN Toolkit.

JSON for Modern C++

Copyright (c) 2013-2017 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2011 - 2015 ARM LIMITED

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

19



- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of ARM nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL COPYRIGHT HOLDERS AND CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2014, Kenneth MacKay

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2006, CRYPTOGAMS by <appro@openssl.org> All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain copyright notices, this list of conditions and the following
disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the CRYPTOGAMS nor the names of its copyright holder and contributors may be
used to endorse or promote products derived from this software without specific prior written permission.
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ALTERNATIVELY, provided that this notice is retained in full, this product may be distributed under the
terms of the GNU General Public License (GPL), in which case the provisions of the GPL apply INSTEAD
OF those given above.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ISC License

Copyright (c) 2013-2017

Frank Denis <j at pureftpd dot org>

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT,
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Copyright (c) 2008 The NetBSD Foundation, Inc.

All rights reserved.

This code is derived from software contributed to The NetBSD Foundation
by Lennart Augustsson (lennart@augustsson.net) at
Carlstedt Research & Technology.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2000 Intel Corporation

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
* Neither name of Intel Corporation nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTEL OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The following applies only to products supporting Wi-Fi.

(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.
* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS," AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Changing the Object Overlapping Order
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Printing as Folded Duplex

Printing Curtains/Banners

Three-sided Borderless Printing
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General Notes (Free Layout plus)

When using Canon Free Layout plus (hereafter Free Layout plus), the following restrictions apply. Please
familiarize yourself with them before using it.

• Free Layout plus supports imagePROGRAF Printer Driver Ver. 5.00 or later for Windows.•

• This guide primarily provides explanations using the screens that are displayed when you use the•
Windows 10 operating system (hereafter, Windows 10).

• Apply the latest Windows Update.•

• If a print job has a large amount of data or multiple pages, the application may not start or the print•
job may fail to be sent from the application. Also, the images may be grainy or defective when they are
printed. In such cases, try the following methods. If you cannot resolve the situation, print directly from
the printer driver, without using Free Layout plus.

◦ Add expanded memory to your PC, or enlarge the virtual memory.◦

◦ If you are using Adobe Illustrator, switch the on/off setting of the Bitmap print item in the print dialog◦
box.

◦ Change the print quality.◦

◦ Open the Print Options dialog box from the Print Settings screen of the printer driver for Canon◦
Free Layout plus to change the settings for the Reduce resolution to prevent loss of print data
check box.

◦ If the OS is the 32 bit version, try the 64 bit version of the OS.◦

• Sometimes the print preview display may different from the actual print position. If this occurs, make a•
slight adjustment in the position of the object.

• The hues of the print preview and the image displayed in the software application (Adobe Photoshop,•
etc.) may be slightly different.

• The appearance of text and fine lines in the print preview may be different from what you see in the print•
result.

• Sometimes a print job can be lost if Free Layout plus is shut down during the print job.•

• When Borderless Printing is set to On, the display in the view includes parts that are trimmed.•

• When you install this software, the virtual printer Canon Free Layout plus is installed. If you want to•
use this software, do not uninstall the virtual printer Canon Free Layout plus.

• Printing is not possible from shared printers or redirected printers.•

• Plug-in functions for Microsoft Office are compatible with the following versions of the application•
software.

◦ Microsoft Word (2013/2016/2019)◦

◦ Microsoft PowerPoint (2013/2016/2019)◦

◦ Microsoft Excel (2013/2016/2019)◦

• The Canon Free Layout plus ribbon might not be displayed in Microsoft Office after installing Free•
Layout plus. For details, refer to "Canon Free Layout plus Ribbon Is Not Displayed" in "Starting from
an Application Supporting Plug-in".
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• When you open an Office document from a web browser, the plug-in does not run correctly.•

• If you are editing an embedded object or link object, the plug-in will not run correctly.•

• If you added the Canon Free Layout plus ribbon to the Microsoft Office Quick Access toolbar, the•
plug-in will not run correctly.

• When using the plug-in, an error dialog box may appear for some data because the information required•
for printing or data analysis cannot be acquired. If this occurs, print from the Canon Free Layout plus
virtual printer driver.

• When using the plug-in, the layout may collapse if you execute Large-format settings using existing•
data. If that is the case, modify the data again.

• When using the plug-in, if the range selected in Microsoft Excel is too large, it will not be possible to•
analyze the data. Select a smaller range and then run the analysis.

• The initial startup and printout may take some time, depending on the environment.•

• Operation may be abnormal if the number of paper sizes registered in the OS exceeds a certain•
number.

• In Startup, If you disable Canon Free Layout plus Service, it will not run correctly.•
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The Features of Free Layout plus

The main features of Free Layout plus are as follows.

Able to Arrange in Various Layouts
• Allows you to lay out at will and print a document created with application software.•

You can save paper by laying out efficiently.

• You can not only lay out multiple pages on one page but also lay out and print a multiple-file•
document on one page, or lay out and print a document created with multiple application programs on
one page.

• Allows you to print an image from one page onto multiple sheets of paper. You can align the printouts•
and glue them together to create a larger printed image.

• Any two pages can be arranged and printed in a layout that becomes duplex on folding.•

This can be used such as for advertising posters that are suspended from the ceiling.

Output Easily from Microsoft Office
• Free Layout plus takes over the Print Plug-In for Office function and you can output from the•

Microsoft Office applications supporting the plugin to Free Layout plus.

• Custom sizes in large-format printing can also be set in a wizard interface from Microsoft Word and•
Microsoft PowerPoint.

• Custom size can be set automatically from Microsoft Excel.•
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Print Preview with Improved User-friendliness
• You can check the layout on the preview screen.•

You can change the layout while checking the actual output image, so you can make the output
workflow efficient.
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Starting Free Layout plus and Inputting Data

Starting from a Regular Application

Starting from an Application Supporting Plug-in

Starting from PosterArtist

Starting from Direct Print & Share

Starting from the Start Menu or the desktop icon
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Starting from a Regular Application

Use the following procedure to start Free Layout plus and load data to print from a regular application
software using Free Layout plus.

1. Open the Print dialog box.1.

To open the Print dialog box, select the print menu in the application software in which the print data is
opened.

Note
• Normally, select Print from the File menu.•

2. Select Canon Free Layout plus from the printers you can use.2.

Note
• If you cannot set the paper size and orientation of the printout in the screen for selecting a printer,•

click Preferences or Printer properties, and do the settings from the Printing Preferences dialog
box. The way to open the Printing Preferences dialog box varies depending on the application.
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• You may be able to improve print results by using the check box for Reduce resolution to•
prevent loss of print data in Print Options.

If the images printed are grainy, clear the check box, and the fine lines printed are thick, select the
check box. However, depending on the data, a print job may occasionally fail.

3. Execute printing.3.

Free Layout plus starts.
The data you edited in the application software appears in the Input Data List on the Home screen.
(See "Free Layout plus Home Screen.")

32



Starting from an Application Supporting Plug-in

To print data of Microsoft Office application software supporting the plug-in by using Free Layout plus, use
the following procedure to start Free Layout plus and input data.

Note
• The following explanation uses the screens that are displayed when you use Microsoft Word.

1. Start Microsoft Word.1.

2. Confirm that the Canon Free Layout plus ribbon is displayed.2.

Important
• If the Canon Free Layout plus ribbon is not displayed, refer to "Canon Free Layout plus Ribbon•

Is Not Displayed".

3. Click Edit/Print.3.

Free Layout plus starts.
The data you edited in the Office application appears in the Input Data List on the home screen. (See
"Free Layout plus Home Screen.")

Canon Free Layout plus Ribbon Is Not Displayed
The Canon Free Layout plus ribbon may not appear in Word, PowerPoint or Excel Office applications,
and the Free Layout plus functions may not be available.

In this event, re-install Free Layout plus.

You can also enable add-ins to display Canon Free Layout plus.

See below for the procedure for re-installing the plug-in or enabling add-ins.

Re-installing Free Layout plus
If a problem occurs, such as the system or an application terminating abnormally, the Office application
disables add-ins as a safety precaution.

In this event, you will need to re-install Canon Free Layout plus to display the Free Layout plus
ribbon.

Note
• You cannot re-install Free Layout plus once an Office application is running. When the message•

appears, select Cancel and close the active Office application.

Re-install Free Layout plus as follows:
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1. Close Office application if it is open.1.

2. Install Free Layout plus.2.

Enable Free Layout plus from the Options in the Office Application
If a problem occurs, such as the system or an application terminating abnormally, the Office application
disables add-ins as a safety precaution.

In this event, you will need to restore the disabled add-ins in order to display the Canon Free Layout
plus ribbon.

Use the procedure below to restore the add-ins disabled by Office application.

1. Select Options from the File menu.1.

Select Options from the File menu on the Office application.

2. From the list on the left side of the <application name> options dialog box, select2.
Add-ins.
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3. From the Manage combo box, confirm the settings in Disabled Items and COM Add-ins.3.

• How to confirm Disabled Items
1. From the Manage combo box, select Disabled Items
2. Click Go button.

3. If Addin :free layout plus plug-in (cnflpaddin.dll) is displayed in the Disabled Items dialog
box, select it and click the Enable button.
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• How to confirm COM Add-ins
1. From the Manage combo box, select COM Add-ins
2. Click Go button.

3. If the Free Layout plus Plug-In check box is not selected in the COM Add-ins dialog box,
click it to select it.
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4. Close all the dialog boxes and restart the Office application.4.
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Starting from PosterArtist

Use the following procedure to start Free Layout plus and load data to print from PosterArtist using Free
Layout plus.

Note
• See the manual for PosterArtist regarding the basic operations for PosterArtist.

1. Start PosterArtist.1.

2. Select a template.2.

3. Set the items in the Paper Options screen, and then check Edit layout with Free Layout3.
plus.

Note
• If you check Edit layout with Free Layout plus, then you cannot set the following items.

Printer
Media Source
Media Type
Roll Paper Width
Borderless Printing
Enlarged/Reduced Printing

• If a message appears related to Free Layout plus after you check Edit layout with Free Layout
plus, click OK.

4. Edit the print data.4.

5. In the Print screen, click Print (Start Free Layout plus).5.

Free Layout plus starts.
The data you edited in PosterArtist appears in the Input Data List on the Home screen. (See "Free
Layout plus Home Screen.")
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Starting from Direct Print & Share

If you are printing data in Direct Print & Share using Free Layout plus, follow the steps below to start Free
Layout plus and input data.

Note
• For basic instructions on how to use Direct Print & Share, see the Direct Print & Share manual.

1. Start Direct Print & Share.1.

2. Edit print content.2.

3. Select "Canon Free Layout plus (Canon Free Layout plus)" from the Printer pulldown3.
menu, and then click Print.

Free Layout plus will start.
The content edited in Direct Print & Share will appear in Input Data List on the Home screen. (See
"Free Layout plus Home Screen")

Note
• If you select Free Layout plus, you can freely edit the layout and print.

However, if you select Free Layout plus, you won't be able to display the Direct Print & Share
layout preview.
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Starting from the Start Menu or the desktop icon

Perform one of the following to start Free Layout plus. The following screenshot is from Windows 10.

Double click the Free Layout plus icon on the desktop.

Free Layout plus starts.

Note
• If you've removed the check mark from Create a shortcut on Desktop in the Installation Complete•

screen, the icon won't be displayed.

From the Taskbar  (Start button), select Canon Utilities > Free Layout plus.

Free Layout plus starts.

Note

• Windows 8.1:•

Select Free Layout plus on the Start screen.

If Free Layout plus is not displayed on the Start screen, select the Search charm, and then search for
"Free Layout plus".

• Windows 7:•

From Start menu,select All Programs > Canon Utilities > Free Layout plus > Free Layout plus.

Adding Data
Add data to Free Layout plus.

1. Click Open from the File menu.1.

The screen to add data appears.

2. Select the data to input.2.

Select the data to input, and then click Open.
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To add more data, repeat steps 1 and 2.

Note
• You can also add data by directly dragging and dropping it onto the Home screen.•

For details, refer to "Free Layout plus Home Screen".

• Supported data types are image data (JPEG/PNG/BMP/TIFF/GIF/PDF), and Office data (Word/Excel/•
PowerPoint).

Only PDF files that are V1.7 or equivalent can be printed.
* However, encryption, JBIG2, font substitution, overprint, and some parts of transparent processing
aren't supported.

• If you cannot input a PDF file, or if the image quality of the print results is coarse, you may be able to•
improve it by following the procedure in "Starting from a Regular Application."

• Data can be input only from the Free Layout plus Home screen.•
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Free Layout plus Screen Explanations

Free Layout plus Home Screen

Fixed Layout Mode

Free Layout Mode

Tiling Mode

Folded Duplex Mode

Favorites

Options Dialog Box

Canon Free Layout plus Ribbon (Office Plug-in)
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Free Layout plus Home Screen

When you start Free Layout plus, the Home screen appears.

In the Home screen, you can select a printer to use and edit modes that suit your objectives.

Menu Bar
This allows you to select menus required for operations.

Input Data List
Displays a list of input data and thumbnails.
Data displayed in this list that has a check mark can be edited after Edit mode is selected. Click a check
box to switch it.

You can also input data from Open in the File menu, or by dragging and dropping it onto the Home
screen.

You can switch the order by dragging the data in the Input Data List.

43



Note
• Right-clicking on a file name in Input Data List and then selecting Delete or pressing the Delete key

allows you to delete that data from the list.
• File input using dragging and dropping is possible only on the Home screen.

Edit mode Sheet
From the Edit mode sheet, you can select a printer to use and an edit mode from four edit modes.
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There are the following four edit modes.

Fixed Layout
Lay out multiple pages to the width of roll paper or on standard size paper, and then print them.

Free Layout
Lay out multiple pages as you like on roll paper, and then print them.

Tiling
Divide a single page, and then print it.

You can align the printouts and glue them together to create a larger printed image.

Folded Duplex
Lay out two pages and print them so you can fold them to create a two-sided printout.

Favorites Sheet
Displayed when you click the Favorites tab. You can select a combination of a printer, an edit mode, and
edit/print settings that have been registered in advance.

See "Favorites" regarding the method to register settings to the Favorites sheet.
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Status Bar
Displays information, such as the number of data that are selected and the paper size.

Note
• You can use the View menu to show or hide the status bar.
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Fixed Layout Mode

Clicking Fixed Layout on the Home screen opens the Fixed Layout mode.
In Fixed Layout mode, you can position data uniformly over the width of roll paper or standard size paper,
and print it.

Menu Bar
This allows you to select menus required for operations.

Main Area
In this area, you can position images and make print settings.

Note

• Click  in the main area to return to the Home screen.

Edit Screen
Set the layout and roll paper width as you check a preview of the print results.
Clicking Next closes editing and moves you to the print settings screen.
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Tool Bar
This allows you to select tool buttons required for major operations.

 Undo
Reverses the last edit.
You can also perform Undo from the Edit menu.

 Redo
Restores the last edit.
You can also perform Redo from the Edit menu.

 Cut
Cuts the selected object.
You can also perform Cut from the Edit menu.

 Copy
Copies the selected object.
You can also perform Copy from the Edit menu.

 Paste
Pastes the cut or copied object.
You can also perform Paste from the Edit menu.

 Delete
Deletes the selected object.
You can also perform Delete from the Edit menu.

 Rotate Left 90 Degrees
Rotates the selected object 90 degrees to the left.
Enabled when Page Layout Printing is set.
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 Rotate Right 90 Degrees
Rotates the selected object 90 degrees to the right.
Enabled when Page Layout Printing is set.

 (Enlarge/Reduce View)
Allows you to change the scaling ratio in the preview screen.

Preview Area
Shows a preview of the print results at the current settings.
You can change the order of the objects by dragging them.

Edit Settings Area
Set the roll paper width and the layout of the page.
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Roll Paper Width
Set the width of the roll paper.

Borderless Printing
Set whether to use borderless printing.
Setting this to On expands the print area to both edges and to the leading edge of the paper.

Enlarge/Reduce
Select the size setting for all objects.
You can match the long or short sides to the width of the roll paper by selecting Fit Short Side
to Roll Paper Width or Fit Long Side to Roll Paper Width.

Align Center
Set the layout of all objects to be aligned centered horizontally on the roll paper.

Erase Margin
Set whether to automatically erase the white area around all objects and fit them to the width
of the page.
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Page Layout Printing
You can conserve paper by printing multiple pages together on one piece of paper.
Select from 2-on-1 Printing / 4-on-1 Printing / 6-on-1 Printing / 9-on-1 Printing / 16-on-1
Printing for the page layout.

Enabled when Borderless Printing is Off.

Page Order
Specify the page order for when doing Page Layout Printing.

Setting item Details

From top-left to right Objects are positioned from top-left to right.

From top-left to bottom Objects are positioned from top-left to bottom.

From top-right to left Objects are positioned from top-right to left.

From top-right to bottom Objects are positioned from top-right to bottom.

From lower-left to right Objects are positioned from lower-left to right.

From lower-left to top Objects are positioned from lower-left to top.

From lower-right to left Objects are positioned from lower-right to left.

From lower-right to top Objects are positioned from lower-right to top.

• When doing 2-on-1 Printing, there are 8 page orders that can be set in Page Layout•
Printing; however, in actuality, the page orders are top to bottom / bottom to top or
left to right / right to left.

• Optimal positioning is automatically done for the page order and the direction of each•
page according to the objects and various settings. If you want to change the default
positioning, change the settings for page order or rotate the objects.

Page Border
A page border can appear around the allocated pages.

On
A page border appears around the area of the allocated pages.

Off
A page border does not appear.

Print Settings Screen
Click Next in the edit screen, and then make the print settings.
You can display previews of print results for each page, and configure print settings.
After setting the various items, click Print to start printing.
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Preview Area
Shows a preview of the print results for each page.

Print Settings Area
Make the settings related to printing, such as the type of paper.
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Media Type
Set the type of paper to print on.

Color
Set either Color or Monochrome for the color to print.

Print Priority
Set the elements to specifically emphasize in the print results.

Print Quality
Select the print quality that suits your objectives.

Print in vivid colors
Set whether to print in vivid colors.

Paper Source
Set the source from which paper is supplied.
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Copies
Set the number of copies to print.

Favorites
You can register the settings that are currently set in the edit screen and the print settings
screen to Favorites by clicking Add. You can easily call up the settings that are registered in
Favorites from the Favorites sheet on the home screen.

Status Bar
Displays information, such as the number of data that are selected and the paper size.

Note
• You can use the View menu to show or hide the tool and status bar.
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Free Layout Mode

Clicking Free Layout on the Home screen opens the Free Layout mode.
In the Free Layout mode, lay out data to be printed as you like on roll paper, and then print it.

Note
• See "Laying Out and Printing Objects as You Like" regarding how to lay out data to print in the Free

Layout mode.

Menu Bar
This allows you to select menus required for operations.

Main Area
In this area, you can lay out images and do print settings.

Note

• Click  in the main area to return to the Home screen.

Edit Screen
Set the layout and roll paper width as you check a preview of the print results.
Clicking Next closes editing and moves you to the print settings screen.
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Tool Bar
This allows you to select tool buttons required for major operations.

 Undo
Reverses the last edit.
You can also execute Undo from the Edit menu.

 Redo
Restores the last edit.
You can also execute Redo from the Edit menu.

 Cut
Cuts the selected object.
You can also execute Cut from the Edit menu.

 Copy
Copies the selected object.
You can also execute Copy from the Edit menu.

 Paste
Pastes the cut or copied object.
You can also execute Paste from the Edit menu.

 Delete
Deletes the selected object.
You can also execute Delete from the Edit menu.

 Rotate Left 90 Degrees
Rotates the selected object 90 degrees to the left.
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 Rotate Right 90 Degrees
Rotates the selected object 90 degrees to the right.

 Crop
Cuts the selected object within any range.
You cannot do other editing operations while cropping.

 Erase Margin
Erases the margin of the selected object.

 Fit
Enlarges or reduces the selected object to fit the width of the roll paper.

 Auto Arrange Object
Lays out all the objects automatically.
You can change the spacing and order of the objects in the Options dialog box.

 Align
Lays out the selected objects in the specified way.
You can select the way to lay out objects by clicking ▼.

 Align Top

 Center Vertically

 Align Bottom

 Align Left

 Center Horizontally

 Align Right

 Grid
Shows gridlines in the preview.

 Rotate View
Rotates the preview 90 degrees to the left. Click it again to go back.

 (Enlarge/Reduce View)
Allows you to change the scaling ratio in the preview screen.

Preview Area
Shows a preview of the print results at the current settings.
In addition, you can change the layout of objects as you like by dragging them.
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Edit Settings Area
Do the settings related to roll paper width and page layout.
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Roll Paper Width
Set the width of the roll paper.

Borderless Printing
Set whether to do borderless printing.
Setting this to On expands the print area to both edges and to the leading edge of the paper.

Page Border
Set the border of objects to print.
Select from None, Full Width (Solid), Full Width (Dotted), or Crop Marks.

Roll Paper Length
Specify the roll paper length to use for printing. Select either Auto or Custom.

If Auto is selected, the length at which all objects fit is calculated and considered to be the length
of the print paper.
If Custom is selected, the value set in Specify Length is the length of the print paper.
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Length
Shows the set Roll Paper Length.

Specify Length
Click to show the dialog box for specifying the Length.
Enabled when Custom in Roll Paper Length is selected.

Print Settings Screen
Click Next in the edit screen, and then do the print settings.
After setting the various items, click Print to start printing.

Preview Area
Shows a preview of the print results.
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Print Settings Area
Do the settings related to printing, such as the type of paper.
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Media Type
Set the type of paper to print on.

Color
Set either Color or Monochrome for the color to print.

Print Priority
Set the elements to specifically emphasize in the print results.

Print Quality
Select the print quality that suits your objectives.

Print in vivid colors
Set whether to print in vivid colors.

Paper Source
Set how the paper is fed.
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Copies
Set the number of copies to print.

Favorites
You can register the settings that are currently set in the edit screen and the print settings screen
to Favorites by clicking Add. You can easily call up the settings that are registered in Favorites
from the Favorites sheet on the Home screen.

Status Bar
Displays information, such as the number of data that are selected and the paper size.

Note
• You can use the View menu to show or hide the tool and status bar.
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Tiling Mode

Clicking Tiling on the Home screen opens the Tiling mode.
In the Tiling mode, divide a single page of input data, and then print it. You can align the printouts and glue
them together to create a larger printed image.

Menu Bar
This allows you to select menus required for operations.

Main Area
In this area, you can select and divide images, and make other print settings.

Note

• Click  in the main area to return to the Home screen.

Page Selection Screen
Select the pages to print.
Clicking Next closes the selection process and moves you to the edit screen.
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Note

• You can change the size of the thumbnails by clicking / / .

Edit Screen
Set the number of divisions and roll paper width as you check a preview of the print results.
Clicking Next closes editing and moves you to the print settings screen.

Tool Bar
This allows you to select tool buttons required for major operations.

65



 Undo
Reverses the last edit.
You can also perform Undo from the Edit menu.

 Redo
Restores the last edit.
You can also perform Redo from the Edit menu.

 Rotate Left 90 Degrees
Rotates the selected object 90 degrees to the left.

 Rotate Right 90 Degrees
Rotates the selected object 90 degrees to the right.

 Crop
Cuts the selected object within any range.
You cannot do other editing operations while cropping.

 Erase Margin
Erases the margin of the selected object.

 (Enlarge/Reduce View)
Allows you to change the scaling ratio in the preview screen.

Preview Area
Shows an image of the print results pasted together using the current settings.

Edit Settings Area
Set the number of divisions and roll paper width, etc.
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Roll Paper Width
Set the width of the roll paper.

Borderless Printing
Set whether to use borderless printing.
Setting this to On expands the print area to both edges and to the leading edge of the paper.

Note
• By setting Borderless Printing to On, the overlap is made only on the right side of each

page, and the page on the very right side is printed on the full width of the roll paper.
• By selecting On in Borderless Printing, the image is printed so a white margin does not•

appear on all four edges of the paper after the printouts are pasted together.

Number of divisions
Set the number of divisions for the objects.

67



Overlap
Set the overlap for pasting together the images that were divided and printed.

On
Prints using a margin with the width specified in Specify Width.

Off
Prints using no margin for the overlap.

Width
Shows the width of the overlap that is set.

Specify Width
Click to show the dialog box for specifying the width.

Set the width of the overlap for pasting together the images that were divided and printed.

Note
• If you set a wide Overlap, the printed area will be that much smaller, so the size of

the printed image after it is pasted together will be smaller.
• A value smaller than 15.00 mm/0.59 inches cannot be set.

Print page range
Select the pages to use for printing.

All
All divided pages are intended for printing.

By page
Divided pages that were clicked on the preview screen are intended for printing.

Total size
Shows an approximation of the size after pasting together the images that were divided and
printed.

Print Settings Screen
Click Next in the edit screen, and then make the print settings.
After setting the required items, click Print to start printing.
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Preview Area
Shows a preview of the print results for each page.

Print Settings Area
Make the settings related to printing, such as the type of paper.
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Media Type
Set the type of paper to print on.

Color
Set either Color or Monochrome for the color to print.

Print Priority
Set the elements to specifically emphasize in the print results.

Print Quality
Select the print quality that suits your objectives.

Print in vivid colors
Set whether to print in vivid colors.

Paper Source
Set how the paper is fed.
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Print "Cut/Paste"
Set whether to print text and guidelines in the cut area and the overlap area.

Copies
Set the number of copies to print.

Favorites
You can register the settings that are currently set in the edit screen and the print settings
screen to Favorites by clicking Add. You can easily call up the settings that are registered in
Favorites from the Favorites sheet on the Home screen.

Status Bar
Displays information, such as the number of data that are selected and the paper size.

Note
• You can use the View menu to show or hide the tool and status bar.
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Folded Duplex Mode

Clicking Folded Duplex on the Home screen opens the Folded Duplex mode.
In the Folded Duplex mode, two pages are printed consecutively. You can create a kind of two-sided
printout by folding it down the middle.
This can be used such as for advertising posters that are suspended from the ceiling.

Menu Bar
This allows you to select menus required for operations.

Main Area
In this area, you can select images and do other print settings.

Note

• Click  in the main area to return to the Home screen.

Page Selection Screen
Select two pages to print in order, front and then back.
Selecting the page to use as the front, and then clicking Next, opens the screen for selecting the page
to use for the back.
Selecting the page to use as the back, and then clicking Next, opens the edit screen.
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Note

• You can change the size of the thumbnails by clicking / / .
• If only one page of input data has been selected on the Home screen, then the edit screen opens,

not the page selection screen, with the same image selected for both front and back.

Edit Screen
Do settings, such as the roll paper width and output size, as you check a preview of the print results.
Clicking Next closes editing and moves you to the print settings screen.

Tool Bar
This allows you to select tool buttons required for major operations.
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 (Enlarge/Reduce View)
Allows you to change the scaling ratio in the preview screen.

Preview Area
Shows a preview of the print results at the current settings.

Edit Settings Area
Set the roll paper width, output size, etc.
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Roll Paper Width
Set the width of the roll paper.

Output Size
Set the output size.

Note
• You can also change the size by specifying the width.

Select Custom size..., and then enter the finished width in the displayed Custom Size
dialog box.

Borderless Printing
Set whether to do borderless printing.
Setting this to On expands the print area to both edges and to the leading edge of the paper.
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Binding Location
Set the binding location when the paper is folded.

Rotate Page 90 degrees
Set whether to rotate pages created in portrait orientation 90 degrees and print them in
landscape orientation.

Fold Line
Set the type of line to show where to fold the page.

Gutter
Set the margin for the gutter.

Print Settings Screen
Click Next in the edit screen, and then do the print settings.
After setting the various items, click Print to start printing.

Preview Area
Shows a preview of the print results.
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Print Settings Area
Do the settings related to printing, such as the type of paper.
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Media Type
Set the type of paper to print on.

Color
Set either Color or Monochrome for the color to print.

Print Priority
Set the elements to specifically emphasize in the print results.

Print Quality
Select the print quality that suits your objectives.

Print in vivid colors
Set whether to print in vivid colors.

Paper Source
Set how the paper is fed.

78



Copies
Set the number of copies to print.

Favorites
You can register the settings that are currently set in the edit screen and the print settings
screen to Favorites by clicking Add. You can easily call up the settings that are registered in
Favorites from the Favorites sheet on the Home screen.

Status Bar
Displays information, such as the number of data that are selected and the paper size.

Note
• You can use the View menu to show or hide the tool and status bar.
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Favorites

You can register a combination of a printer to use, an edit mode, and settings in the edit mode, and save it
to Favorites.
By registering combinations that you frequently use, you can eliminate the task of having to set them each
time.

Add to Favorites Dialog Box
To open the Add to Favorites dialog box, click Add in Favorites on the print settings screen for any of
the edit modes.
Click OK to register the settings that are displayed to favorites.

Note
• In the Add to Favorites dialog box, you can only edit the Name. If you want to change the registered•

settings, click Cancel to return to the edit mode. After you change the settings in the edit screen and
the print settings screen, open the Add to Favorites dialog box again.

Edit Favorites Dialog Box
To open the Edit Favorites dialog box, click Edit Favorites on the Favorites sheet on the Home screen.
In the Edit Favorites dialog box, you can confirm settings in Favorites that have been registered, change
the Name, and delete Favorites.
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Favorites List
The favorite names registered in Name appear in the list.
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Settings display area
Shows the settings for the favorite that is selected in the list of favorites.
You can also edit the content of Name.
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Delete
Clicking this deletes the favorite that is selected in the list of favorites.
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Options Dialog Box

To open the Options dialog box, click Options from the File menu on the menu bar.

General
Set the general items related to Free Layout plus.
Units

Set the unit for length that you use.

Display print confirmation dialog
Add a check mark to make the print confirmation dialog box appear when you click Print in the
Print Settings Screen.

Free Layout
Set the items related to Free Layout mode.
Gridlines

Set the distance between lines in the grid.
You can set a distance from 10.0 mm/0.39 inches to 200.0 mm/7.87 inches.

Spacing
Set the spacing between objects when objects are automatically arranged.
You can set a distance from 0.0 mm/0.00 inches to 100.0 mm/3.94 inches.

Order
Set the direction for auto arrangement.

Maintain object size
The object size will be retained, including the margins.
If you remove the check mark, the size will be changed to the size of the object with the margins
removed.
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Defaults
Returns the settings in the Options dialog box to their default values.
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Canon Free Layout plus Ribbon (Office Plug-in)

The Canon Free Layout plus ribbon can be used by starting an application that supports Microsoft Office
plugins on a computer in which Free Layout plus is installed.

Important
• If the Canon Free Layout plus ribbon is not displayed, refer to "Canon Free Layout plus Ribbon Is•

Not Displayed".

Note
• The following explanation uses the screens that are displayed when you use Microsoft Word.

Edit/Print
Edit/Print

Free Layout plus starts.
The data you edited in the Office application appears in the Input Data List on the home screen.
(See "Free Layout plus Home Screen.")

Print Range
Set the range of data that is input to Free Layout plus when Edit/Print is clicked.

Large-format settings
Banner

Set paper sizes that are suitable for long documents, such as banners. (See "Printing Curtains/
Banners.")

Curtain
Set paper sizes that are suitable for long documents, such as curtains. (See "Printing Curtains/
Banners.")

Note
• Large-format settings does not appear in Microsoft Excel.

Other
Help

Opens Help.

About
Displays the version of Free Layout plus.

Special Settings
Displays the Special Settings dialog box.
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Ensure image quality when creating page sizes
Select this to create documents at the maximum size. When printing, the scale ratio is low so
the degradation in quality of images, such as photos, is minimized.
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Various Free Layout plus Features

Inputting Multiple-file Documents into Free Layout plus

Inputting Documents Created Using Multiple Applications into Free Layout plus

Correctly Laying Out and Printing Objects

Laying Out and Printing Objects as You Like

Selecting an Object

Changing the Object Size

Moving an Object

Rotating an Object

Laying out Objects Automatically

Aligning Objects

Changing the Object Overlapping Order

Pasting a Copied or Cut Object

Dividing and Printing Objects

Printing as Folded Duplex

Printing Curtains/Banners

Three-sided Borderless Printing
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Inputting Multiple-file Documents into Free Layout plus

Input multiple-file documents and then manipulate them in Free Layout plus.

1. Open the file you want to print, and then start Free Layout plus by using one of the1.
procedures in "Starting Free Layout plus and Inputting Data."

Free Layout plus starts and the file that is opened is displayed in Input Data List.

2. While Free Layout plus is running, open a separate file that you want to print, and then2.
execute one of the procedures in "Starting Free Layout plus and Inputting Data."

The data opened in step 2 is added to the Input Data List in Free Layout plus.
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3. Repeat step 2 until all the data you want to print appears in Input Data List.3.

4. Lay out and print data using various Free Layout plus features.4.

For details, see the following.

Correctly Laying Out and Printing Objects
Laying Out and Printing Objects as You Like
Dividing and Printing Objects
Printing as Folded Duplex
Printing Curtains/Banners
Three-sided Borderless Printing
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Inputting Documents Created Using Multiple Applications into
Free Layout plus

Input documents created using multiple applications into Free Layout plus, and then manipulate them.

1. Open the file you want to print, and then start Free Layout plus by using one of the1.
procedures in "Starting Free Layout plus and Inputting Data."

Free Layout plus starts and the file that is opened is displayed in Input Data List.

2. While Free Layout plus is running, open a file from a separate application that you want2.
to print, and then execute one of the procedures in "Starting Free Layout plus and Inputting
Data."

The data opened in step 2 is added to the Input Data List in Free Layout plus.
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3. Repeat step 2 until all the data you want to print appears in Input Data List.3.

4. Lay out and print data using various Free Layout plus features.4.

For details, see the following.

Correctly Laying Out and Printing Objects
Laying Out and Printing Objects as You Like
Dividing and Printing Objects
Printing as Folded Duplex
Printing Curtains/Banners
Three-sided Borderless Printing
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Correctly Laying Out and Printing Objects

Lay out multiple pages in order, and then print them.

1. Open the file you want to print, and then start Free Layout plus.1.

For details about starting procedures, see "Starting Free Layout plus and Inputting Data."

Note
• If you want to layout multiple images in different files, while Free Layout plus is running, open the

data you want to add, and repeat the operation in step 1.

2. Click Fixed Layout.2.

The edit screen in the Fixed Layout mode is displayed.

3. Set the order of the images to print, Roll Paper Width, and other settings, and then click3.
Next.
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For details about how to do settings in the edit screen, see "Edit Screen" in "Fixed Layout Mode."

The print settings screen in the Fixed Layout mode is displayed.

4. After setting the items related to printing, click Print.4.

For details about how to do settings in the print settings screen, see "Print Settings Screen" in "Fixed
Layout Mode."

Printing starts.
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Laying Out and Printing Objects as You Like

Lay out multiple pages as you like, and then print them.

1. Open the file you want to print, and then start Free Layout plus.1.

For details about starting procedures, see "Starting Free Layout plus and Inputting Data."

Note
• If you want to layout multiple images in different files, while Free Layout plus is running, open the

data you want to add, and repeat the operation in step 1.

2. Click Free Layout.2.

The edit screen in the Free Layout mode is displayed.

3. Set the layout of the images to print, Roll Paper Width, and other settings, and then click3.
Next.
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For details about how to do settings in the edit screen, see "Edit Screen" in "Free Layout Mode."
For details about operations for objects in the preview, see the following.

Selecting an Object
Changing the Object Size
Moving an Object
Rotating an Object
Laying out Objects Automatically
Aligning Objects
Changing the Object Overlapping Order
Pasting a Copied or Cut Object

The print settings screen in the Free Layout mode is displayed.

4. After setting the items related to printing, click Print.4.
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For details about how to do settings in the print settings screen, see "Print Settings Screen" in "Free
Layout Mode."

Printing starts.
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Selecting an Object

To select an object, click that object.
When an object is selected, a select box (red border) appears around the object, and the height and width of
the object are shown on the left side.

To select multiple objects, perform the following.

• To select multiple successive objects, click them while holding down the Shift key.•

• To select multiple arbitrary objects, click them while holding down the Ctrl key.•

• To select all objects, select Select All from the Edit menu.•

• When you specify the area with dragging the mouse, the object in the area is selected.•
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Changing the Object Size

You can change the size of the selected object.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.•

1. Select an object.1.

(See "Selecting an Object.")

2. Change object size.2.

Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag
this handle to change the object size.

Note

• You can also fit the size of the object to the width of the roll paper by clicking  Fit on the tool bar.•

• You can also change the size by specifying it.•
Select Resize... from the right-click menu. Then, enter the size in the displayed Object Size dialog box.
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Moving an Object

You can move the position of the selected object.

1. Select an object.1.

(See "Selecting an Object.")

2. Moving an Object.2.

Place the pointer inside the selection box of the object to show the crosshair handle, and drag it to move
the object.
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Rotating an Object

You can rotate the selected object.

1. Select an object.1.

(See "Selecting an Object.")

2. Select rotation direction.2.

Select  Rotate Left 90 Degrees or  Rotate Right 90 Degrees from the toolbar.

Note
• You can also rotate and object by right clicking the mouse on the object, and then selecting Rotate Left•

90 Degrees or Rotate Right 90 Degrees.
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Laying out Objects Automatically

Click Auto Arrange Object from the toolbar.

Automatically positions the object.

Note
• The object layout order varies depending on the Free Layout setting in the Options Dialog Box.•

103



Aligning Objects

You can align objects systematically.

1. Select multiple objects.1.

Select multiple objects to align. (See "Selecting an Object.")

2. Click  Align from the toolbar.2.

An icon appears indicating the alignment method.

3. Click the icon that indicates the alignment method.3.

 Align Top
Lays out the objects, justifying them to the top.

 Center Vertically
Lays out the objects, justifying them to the vertical center.
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 Align Bottom
Lays out the objects, justifying them to the bottom.

 Align Left
Lays out the objects, justifying them to the left.

 Center Horizontally
Lays out the objects, justifying them to the horizontal center.
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 Align Right
Lays out the objects, justifying them to the right.
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Changing the Object Overlapping Order

You can change the object overlapping order.

1. Select an object.1.

Select an object whose overlapping order you want to change. (See "Selecting an Object.")

2. Right click the object and select the overlapping order menu.2.

The following variations appear in the overlapping order menu.

Bring to Front
Moves the object to the frontmost position.

Send to Back
Moves the object to the backmost position.

Bring Forward
Moves the object one position to the front.
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Send Backward
Moves the object one position to the back.

Note
• The order of overlapping affects the order of objects automatically laid out.•
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Pasting a Copied or Cut Object

1. Select an object.1.

Select an object to copy or cut. (See "Selecting an Object.")

2. Execute Copy or Cut.2.

Click  Copy or  Cut from the toolbar.

Alternatively, you may select Copy or Cut from the Edit menu.

3. Paste object.3.

Click  Paste from the toolbar.

Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.•

• You can also select by clicking the right button of the mouse on an object.•
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Dividing and Printing Objects

Divide a single page, and then print it.
You can align the printouts and glue them together to create a larger printed image.

1. Open the file you want to print, and then start Free Layout plus.1.

For details about starting procedures, see "Starting Free Layout plus and Inputting Data."

2. Click Tiling.2.

The page selection screen in the Tiling mode appears.

3. Select one page to print, and then click Next.3.

110



The edit screen in the Tiling mode appears.

4. Set the Roll Paper Width, Number of divisions, and other settings, and then click Next.4.

For details about how to do settings in the edit screen, see "Edit Screen" in "Tiling Mode."

The print settings screen in the Tiling mode appears.
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Note
• By selecting On in Borderless Printing, the image is printed so a white margin does not appear•

on all four edges of the paper after the printouts are pasted together.

5. After setting the items related to printing, click Print.5.

For details about how to do settings in the print settings screen, see "Print Settings Screen" in "Tiling
Mode."

Printing starts.
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Printing as Folded Duplex

This prints 2 pages consecutively.
You can create a kind of two-sided printout by folding it down the middle. This can be used such as for
advertising posters that are suspended from the ceiling.

1. Open the file you want to print, and then start Free Layout plus.1.

For details about starting procedures, see "Starting Free Layout plus and Inputting Data."

Note
• If you want to lay out different data images for the front and back, while Free Layout plus is

running, open the other data, and repeat the operation in step 1.

2. Click Folded Duplex.2.

The page selection screen in the Folded Duplex mode is displayed.

3. Select one page to print on the front, and then click Next.3.

113



Note
• If only one page of input data has been selected on the Home screen, then the edit screen opens,

not the page selection screen, with the same image selected for both front and back. Go to step 5.

4. Select one page to print on the back, and then click Next.4.

The edit screen in the Folded Duplex mode is displayed.

5. Set the Roll Paper Width, Binding Location, and other settings, and then click Next.5.
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For details about how to do settings in the edit screen, see "Edit Screen" in "Folded Duplex Mode."

The print settings screen in the Folded Duplex mode is displayed.

6. After setting the items related to printing, click Print.6.

For details about how to do settings in the print settings screen, see "Print Settings Screen" in "Folded
Duplex Mode."

Printing starts.
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Printing Curtains/Banners

Print a document you created in Microsoft Word or Microsoft PowerPoint to fit the entire width of the roll
paper.
You can use this to print curtains or banners.

The procedure here is explained using the creation of a curtain as an example.

1. Start Microsoft Word or Microsoft PowerPoint.1.

2. Select Canon Free Layout plus ribbon.2.

3. Click Curtain in Large-format settings.3.

4. Set the Roll Paper Width and Length, and then click OK.4.

Sets the size of the paper for editing; long paper for curtains and wide paper for banners.

Note
• If you select Custom Size for Roll Paper Width, you can set the roll paper width to your preferred•

value.
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5. If a message appears, check the content, and then click OK.5.

6. Edit and create a document.6.

Create a document on the size of paper you created.

7. Click Edit/Print.7.

Free Layout plus starts when the document you created appears in Input Data List.

8. Click Fixed Layout.8.

The edit screen in the Fixed Layout mode is displayed according to the size of the paper you created.

9. Click Next.9.

The print settings screen in the Fixed Layout mode is displayed.

Important
• If the settings in the edit screen are changed, you may not be able to print on the paper size you•

created. Click Next without changing the settings.

10. After setting the items related to printing, click Print.10.

For details about how to do settings in the print settings screen, see "Print Settings Screen" in "Fixed
Layout Mode."
Printing starts.

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data•

again.
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Three-sided Borderless Printing

Print with margins added only to the right side for each page.
In normal borderless printing, paper sizes that match the width of the roll paper are combined to print without
borders on all four sides.
If you use the three-sided borderless printing feature, you can combine paper sizes that don't match the
roll paper width, and print with no borders on three sides. However, if you perform three-sided borderless
printing, you need to cut the right side of the paper after printing.

1. Open the file you want to print, and then start Free Layout plus.1.

To learn how to start it, see "Starting Free Layout plus and Inputting Data."

2. Click Fixed Layout on the Home screen.2.
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The page settings screen in Fixed Layout mode will appear.

3. Select On for Borderless Printing.3.

4. Set the size with Enlarge/Reduce, and then click Next.4.

To learn about settings in the edit screen, see "Edit Screen" under "Fixed Layout Mode."

Note
• Fit Short Side to Roll Paper Width is set in initial settings.
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• If the original size of all pages fit within the roll paper width, Match Page Size will also appear in
the pulldown menu.

• If the document size and the paper size that you want to print are different, select the paper size
you want to print from the pulldown menu.

5. Set the items related to printing, and then click Print.5.

To learn about settings in the print settings screen, see "Print Settings Screen" under "Fixed Layout
Mode."

Printing will start.

6. Cut the right side of the paper6.

Cut the margin on the right side of the paper with scissors after printing.
To get the document to standard size, it is recommended to take measurements and cut in the correct
positions.

Important
• If Borderless Printing is On, Align Center is grayed out, and can't be set.
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